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Create or Select a Job
A job in Carlson SurvCE is made up of several file, however, the main two file are the coordinate
file (*.crd) and the raw data file (*.rw5). To create a job:

1. Select the File tab and menu item 1, Job.
2. Enter the job name (e.g. Tutorial1).

Note: Opening an existing job is performed the same way except you select a job name as
opposed to entering one.
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Define Job Settings
By default the software will prompt for the job units upon job creation by presenting the Job
Settings dialog. This setting is optional and can be found on the New Job tab.

To access Job Settings after closing the dialog, select the file tab and menu item 2, Job Settings.
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Units
The Units tab is where the initial job units must be specified.

1. Select the Units tab of Job Settings if not already there.
2. Set the job units to Feet, US Feet or Meters as required by the job.

You cannot change the job distance units once a point has been recorded (i.e. convert
it from feet to meters).
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Format
Select the Format tab to set up how the data is to be displayed in measurement screen (e.g.
coordinate order).
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Options
Select the Options tab if you would like to use a Control file. The rest of the settings shown
below should be typical for most projects.
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Stakeout
The stakeout tab is where you define the precision of the stakeout values that are reported
during stakeout and where cutsheet (a.k.a. grade sheet) files can be setup.

1. Select the Stakeout tab of Job Settings.
2. Select the desired decimal precision.
3. Select the Set Cutsheet Format button.
4. Turn on the Point Stakes toggle.
5. Select the Select File button.
6. Enter a name for the cutsheet (e.g. Tutorial1_Pts).
7. Select OK to save the file name.
8. Select OK to close the point cutsheet Settings dialog.
9. Setup the remaining cutsheets if applicable.
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Total Station Surveying
By default the software will prompt to create the first point in the project. This setting is optional
and can be found on the New Job tab. This option is useful for users that tend to start projects
from scratch and intend to enter the initial coordinates for the instrument to occupy.

You must first configure your equipment to communicate with the data collector by selecting
Total Station on the Equip tab. For details about a specific instrument, see the User Manual.

Common equipment settings can be found in the Equipment Settings section of this
tutorial.
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Localization
Localization is where all projection, scale and total station adjustment options are located. Turn
on the curvature and refraction option. This is recommended for total station jobs where live
elevations are important.
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Enter Occupied Point Coordinates
For total station surveys, SurvCE requires there to be at least one point in the job. If the prompt
to enter the staring coordinates was off and/or you want to enter more than one point, select
item 3, List Points, from the File tab. Or You can simply try to enter any measurement routine
and if there are no points in the job, you will be prompted to enter one.

1. Select List Points from the File tab.
2. Select the Add button.
3. Enter the point coordinates.
4. Select OK to save the point.
5. Select Close to exit List Points.
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Instrument Setup
The first time you enter a measurement routine you will be prompted for the instrument setup
information and required to perform a backsight measurement. Each time thereafter you will be
prompted to verify that the information is still correct and can select the OK button to enter the
routine or choose to modify the orientation data and perform another backsight.

If the backsight point is unknown, the software will allow the entry of the backsight direction. If
the backsight point is unknown and a backsight prism is measured, the point will be computed
and stored to the project.

1. Enter the Occupied Point ID.
2. Enter the Instrument Height.
3. Enter the Backsight Point ID (even if the point does not exist, an ID is required).
4. Enter the Backsight Target Height.
5. Select the Backsight button.
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Backsight
The backsight dialog allows the user to set or check the backsight circle of the instrument. If
backsighting a point for the first time, always set the circle. If returning to check into the
backsight always use the check options.

1. Sight the backsight prism and select Set Angle and Read. If the backsight cannot be
measured to, select Set Angle.

2. Select OK to Store the backsight point if the point was unknown.
3. Select OK to enter the routine.
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Store Data with Store Data with Store Points
The routine used for collecting survey data using a total station is called Store Points and is
found on the Survey tab of the main menu.
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Recording Data
The graphic view of Store Points is shown below. The user can Configure to be prompted for the
height and description after the reading is taken, or choose to enter the data prior to the
reading. Alternately, the user can select TEXT mode from the SurvCE icon to use a non-graphical
interface to collect the data.

1. Select Enter or R to Read.
2. Select Enter or S to Store.

TEXT Mode Exit

Zoom Extents Read

Zoom In Store

Zoom Out Traverse

Zoom Window Offset

Zoom Previous Configure

View Options
Instrument
Setup

Tips:

1. The Enter button can be used to Read and Store.
2. To enter the description after the reading, turn on the Hgt/Desc Prompt on Save option using

the C for Configure icon or by selecting menu item 5, Configure from the Equip tab.
3. You must select R to Read prior to using T to Traverse.
4. All off-center readings are accessed through the O for Offset icon.
5. To change the behavior of the Enter key, select the C for Configure icon.
6. To only view linework and the last measured point, select the View Options icon or ALT-F.
7. To draw linework you must have fieldcodes established in the Feature Code List found on the

File tab.
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Stake Points
The routine used for staking out pre-calculated points is called Stake Points and is found on the
Survey tab of the main menu.
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Defining the Point to Stake
In order to stake a pre-calculated location you must enter the point ID or coordinates into the
dialog that is presented when you enter Stakeout Points.

1. Enter the Stakeout Point ID.
2. Select OK to Stake the Point.

Tips:

1. Point by Direction can be used to quickly enter an offset location from the stake Point ID.
2. Math functions can be performed in the direction input boxes to solve inverses, etc... (e.g.

1,2 in the azimuth field would return the azimuth between points 1 and 2).
3. Math functions can also be used to quickly calculate distances in the distance input boxes

(e.g. 1,2/2 would return 1/2 the distance between points 1 and 2).
4. Multiple points can be selected using the List icon to the right of the Point ID input box or by

entering them separated by commas.
5. The Add to List button will add all points entered into the Point ID input box to the Stakeout

Point List.
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Staking Out the Point
The graphic view of Stakeout Points is shown below. Alternately, the user can select the TEXT
button to use a non-graphical interface to stakeout the point. The software will show the Turn-To
angle at the start unless running robotically. If running robotically or after each reading, the
navigational information will be presented.

1. Select Enter or R to Read.
2. Select Enter or S to Store.

TEXT Mode Exit

Zoom Extents Read

Zoom In Store

Zoom Out Next (Point)

Zoom Window Modify

Zoom Previous Configure

View Options Instrument
Setup

Tips:

1. Use M for Modify to enter or adjust the stake location.
2. Use N for Next to advance to the next point ID.
3. To change the behavior of the Enter key, select the C for Configure icon.
4. To only view linework and the last measured point, select the View Options icon or ALT-F.
5. To change the method that the navigation information is reported, select C for Configure and

then the Reference tab. This is where the stakeout perspective can be changed from rod to
instrument for example.
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GPS Surveying
Prior to starting a GPS survey, you must define the project coordinate system and set the GPS
settings in Localization, located on the Equip tab as menu item 6.

1. Select the System tab of Localization.
2. Select the Edit Projection List button.
3. Select the Add Predefined button.
4. Choose the Grid coordinate system for the project area.
5. Select OK to close the Coordinate Projection dialogs.
6. Select the project projection to make it current.

If you plan to use GPS and have less than 4 control points for the project, it is recommended
that a geoid file be applied.

1. Create and transfer a geoid file to SurvCE using Carlson X-Port (see Create a Geoid File
section).

2. Select the Geoid Separation File button.
3. Select the created geoid file and select OK.

You also must setup the GPS equipment by selecting menu item 2 or 3 on the Equip tab. Once
the type of Instrument has been selected, operational settings must be defined. For details about
a specific instrument, see the User Manual.



20

Menu item 2, GPS Base on the Equip tab allows the user to set the operational settings of the
Base Station and also provides several options for starting the survey.

Menu item 3, GPS Rover simply established the operational settings of the rover.

Common equipment settings can be found in the Equipment Settings section of this
tutorial.
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Create a Geoid File
Carlson X-Port and Carlson Geoid Grids are installed separately. They are both located on the
Carlson SurvCE CD or they can be downloaded from:

http://update.carlsonsw.com/public/CarlsonGeoidGrids.exe

1. Install Carlson X-port (XportSetup.exe). Use the serial number listed in the back of your
SurvCE manual (it should be listed as X-port serial # and start out like this: “133…”). You
can also use the Data Transfer option in Carlson Survey or Carlson SurvCadd in lieu of
Carlson X-Port.

2. Install the Carlson Geoid Grids (CarlsonGeoidGrids.exe).

Once you have finished installing Carlson X-port and the geoid grid files you can now create a
geoid file and transfer it to the data collector as follows:

1. Hook up the data collector to the computer with the 9pin or USB cable.
2. Turn on the Explorer and launch SurvCE.
3. On the data collector select menu item 6, Data Transfer from the File tab.
4. Select Carlson Transfer (it should say awaiting connection).
5. On the desktop computer, launch Carlson X-port and select menu item Data Transfer from

the Tools menu.
6. Select Data Transfer sub-menu item SurvCE/G2/FastSurvey… to launch the SurvCOM dialog.
7. Select the Geoid button in the bottom right corner of the SurvCOM dialog.
8. Click the select button and navigate to the directory you installed the Geoid Grids to.
9. Key in the approximate Latitude and Longitude for the center of your project, the Grid Size

and the File Name that you want store the geoid file as. Normally you would want to make a
100-150 mile grid file or 2 degrees (2 deg = 124 miles) for best performance.

10. Select OK to make the geoid file and copy it to the data collector.
11. Once the transfer is complete, close X-Port and disconnect from the data collector.
12. Close the Data Transfer dialog on the data collector and set the geoid file by selecting the

GPS tab of Job Settings located as menu item 2 on the File tab.

 

 

http://update.carlsonsw.com/public/CarlsonGeoidGrids.exe
http://update.carlsonsw.com/public/CarlsonGeoidGrids.exe
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Base Setup - Unknown Autonomous Location
This section covers how to setup the base at an unknown location with the assumption that the
site localization will be established using the rover.

1. Select menu item 2, GPS Base on the Equip tab.
2. Establish the operational and communication settings.
3. Enter the Base Antenna Height.
4. Select OK.
5. At the Base Configuration dialog, select Read from GPS from the From New Position tab.
6. At the Average GPS dialog, enter the Number of Samples (Epochs) to measure and average.
7. Select OK to begin measuring.
8. Select OK to close the results dialog if the results are acceptable.
9. Enter the base reference ID if prompted. For Trimble users, this is the broadcast ID and

should be between 0 and 31 for CMR and between 0 and 1023 for RTCM.
10. When prompted to save the reference file, answer Yes in case you need to set the base at

this location again.
11. Unplug from the base station.

At this point the base has established a position based on averaging the autonomous readings
taken in step 6 and should be broadcasting corrections from this location.

To setup at this location again: Use the Read from Reference File process.
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Base Setup - Published Known Location
This section covers how to setup the base at a published known location (e.g. Government
Control Point) with the assumption that the site is to be based on the published coordinate
system.

If Published Values are Latitude and Longitude:

1. Select menu item 2, GPS Base on the Equip tab.
2. Establish the operational and communication settings.
3. Enter the Base Antenna Height.
4. Select OK.
5. At the Base Configuration dialog, select Enter Lat/Lon from the From New Position tab.
6. At the Enter Lat/Lon dialog, enter the published latitude, longitude and ellipsoid or

orthometric height. Note that if a geoid file was not applied in Job Settings that the ellipsoid
height is the only option.

7. When prompted to continue, verify the coordinates and select Yes.
8. Enter the base reference ID if prompted. For Trimble users, this is the broadcast ID and

should be between 0 and 31 for CMR and between 0 and 1023 for RTCM.
9. When prompted to save the reference file, answer Yes in case you need to set the base at

this location again and do not have the coordinates handy.
10. Unplug from the base station.

At this point the entered published position was sent to the receiver and the base should be
broadcasting corrections from this location.

To setup at this location again: Use the Read from Reference File process.

If Published values are Grid System coordinates:

1. Select menu item 2, GPS Base on the Equip tab.
2. Establish the operational and communication settings.
3. Enter the Base Antenna Height.
4. Select OK.
5. At the Base Configuration dialog, select Enter Grid System Coordinates.
6. At the Grid Coordinate dialog, enter the published coordinates and ellipsoid or orthometric

height. Note that if a geoid file was not applied in Job Settings that the ellipsoid height is the
only option.

7. When prompted to continue, verify the coordinates and select Yes.



24

8. Enter the base reference ID. For Trimble users, this is the broadcast ID and should be
between 0 and 31 for CMR and between 0 and 1023 for RTCM.

9. When prompted to save the reference file, answer Yes in case you need to set the base at
this location again and do not have the coordinates handy.

10. Unplug from the base station.

At this point the entered published position was sent to the receiver and the base should be
broadcasting corrections from this location.

To setup at this location again: Use the Read from Reference File process.
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Base Setup - Assumed or Local Coordinates
This section covers how to setup the base at a location where the coordinates are either assumed
or have been established as a local system.

1. Select menu item 2, GPS Base on the Equip tab.
2. Establish the operational and communication settings.
3. Enter the Base Antenna Height.
4. Select OK.
5. At the Base Configuration dialog, select Use Local Coordinates from the From Known Position

tab.
6. At the Local Point dialog, enter the local coordinates or select the job point. Note that a geoid

file should be applied in Job Settings.
7. When prompted to save a localization file, select OK.
8. When prompted to continue, select Yes.
9. Enter the base reference ID if prompted. For Trimble users, this is the broadcast ID and

should be between 0 and 31 for CMR and between 0 and 1023 for RTCM.
10. When prompted to save the reference file, answer Yes in case you need to set the base at

this location again.
11. Unplug from the base station.

At this point a localization was created by pairing the entered local coordinate and a GPS reading
from the base station. The base should now be broadcasting corrections from this location.

To setup at this location again: Use the Read from Reference File process.
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Base Setup - Read from  Reference File
This section covers how to setup the base at a location that was previously occupied by the base
station and the reference file was saved.

1. Select menu item 2, GPS Base on the Equip tab.
2. Establish the operational and communication settings.
3. Enter the Base Antenna Height.
4. Select OK.
5. At the Base Configuration dialog, select Read from File from the From Known Position tab.
6. When prompted, select the previously saved reference file and select OK.
7. When prompted to continue, select Yes.
8. Enter the base reference ID if prompted. For Trimble users, this is the broadcast ID and

should be between 0 and 31 for CMR and between 0 and 1023 for RTCM.
9. Select OK when presented with the Base Setup Successful message.
10. Unplug from the base station.

At this point the original GPS position in the reference file was sent to the receiver and the base
should be broadcasting corrections from this location.
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Base Setup - Previously Surveyed Rover Point
This section covers how to setup the base at a location that was previously surveyed by the rover
and the GPS record exists in the raw data file.

1. Select menu item 2, GPS Base on the Equip tab.
2. Establish the operational and communication settings.
3. Enter the Base Antenna Height.
4. Select OK.
5. At the Base Configuration dialog, select Previously Surveyed Point from the From Known

Position tab.
6. When prompted, select the Surveyed Point and select OK.
7. When prompted to continue, select Yes.
8. Enter the base reference ID if prompted. For Trimble users, this is the broadcast ID and

should be between 0 and 31 for CMR and between 0 and 1023 for RTCM.
9. When prompted to save the reference file, answer Yes in case you need to set the base at

this location again and don't have the raw data file.
10. Unplug from the base station.

At this point the original GPS position was sent to the receiver and the base should be
broadcasting corrections from this location.

To setup at this location again: Use this method or the Read from Reference File process if you
no longer have the raw data file.
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Rover Setup
Select menu item 3, GPS Rover, and simply established the operational and communication
settings. You can also select menu item 4, Receiver Utilities to establish various radio
parameters.

Tip:

1. Check that you have a fixed position before leaving the base station by selecting menu item
6, Monitor/SkyPlot. If you are autonomous, you are not getting base correction and likely
have issues with the radio settings.
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Localization
Localization is a process that allows the user to shift the GPS measurements to a local coordinate
system. It is recommended that a geoid file be applied in Job settings prior to localizing. It is
also recommended that if the localization if going to have any less than 4 horizontal and vertical
control points that a geoid file be applied.

To adjust to local control:

1. Select menu item 3, GPS Rover on the Equip tab and establish the operational settings of the
rover.

2. Check that you have a fixed position by selecting menu item 7, Monitor/SkyPlot. If you are
autonomous, you are not getting base correction and likely have issues with the radio
settings.

3. Select menu item 6, Localization on the Equip tab.
4. Select the Add button.
5. Enter the local coordinates or select a local point from the job. Note that you do not enter a

point ID if the point does not exist in the current job.
6. Select Read from GPS when prompted for the GPS Coordinates.
7. At the Average GPS dialog, enter the Number of Samples (Epochs) to measure and average.
8. Select OK to begin measuring.
9. At the Average Results dialog, select OK if all samples were OK. If not, cancel and measure

again.
10. To add more than one point, repeat steps 1 through 9.
11. Select OK to save the localization file.

If the scale factor is 1.0 is Job Settings, then the coordinates will be Grid coordinates. If a value
is entered, the vector distance from the first point in the localization file to the current position
will be divided by the entered value.

If the localization determines a scale factor because more than one point is held horizontally,
then the scale factor in Job Settings is grayed out and reflects the local to grid factor.
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Survey at Ground Coordinates - GPS North
To survey with ground coordinates and GPS North:

1. Select menu item 3, GPS Rover on the Equip tab and establish the operational settings of the
rover.

2. Check that you have a fixed position by selecting menu item 7, Monitor/SkyPlot. If you are
autonomous, you are not getting base correction and likely have issues with the radio
settings.

3. Localize to a single point, if you did not use the Base Setup - Assumed or Local Coordinates
option. If you did use this option, go to step 4.

4. Select the GPS tab of Localization.
5. Select Read GPS to enter the combined factor that will get you to ground coordinates.

At this point you are surveying on a local system with coordinates that would match a total
station.
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Survey at Ground Coordinates - Rotated Orientation
To survey with ground coordinates using a project orientation that fits two local coordinates:

1. Select menu item 3, GPS Rover on the Equip tab and establish the operational settings of the
rover.

2. Check that you have a fixed position by selecting menu item 7, Monitor/SkyPlot. If you are
autonomous, you are not getting base correction and likely have issues with the radio
settings.

3. Localize to a single point, if you did not use the Base Setup - Assumed or Local Coordinates
option. If you did use this option, go to step 4.

4. Localize to a second point that has known local coordinates.
5. Toggle on the 2Pt Rotate Only option.
6. Select the GPS tab of Localization.
7. Select Read GPS to enter the combined factor that will get you to ground coordinates.
8. Select OK to save the localization.
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Store Data with Store Points
The routine used for collecting survey data using GPS is called Store Points and is found on the
Survey tab of the main menu.
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Recording Data
The graphic view of Store Points is shown below. The user can Configure to be prompted for the
height and description after the reading is taken, or choose to enter the data prior to the
reading. Alternately, the user can select the TEXT button to use a non-graphical interface to
collect the data.

1. Select Enter or S to Store or Select A to Store an Averaged reading.

TEXT Mode Exit 

Zoom Extents Store

Zoom In Average

Zoom Out Offset

Zoom Window Configure

Zoom Previous

View Options
Monitor
SkyPlot

Tips:

1. The Enter button can be used to Read and Store.
2. To enter the description after the reading, turn on the Hgt/Desc Prompt on Save option using

the C for Configure icon or by selecting menu item 5, Configure from the Equip tab.
3. All off-center readings are accessed through the O for Offset icon.
4. To change the behavior of the Enter key, select the C for Configure icon.
5. To change the number of epochs that Enter and S will read, select C for Configure and

change the Number of Readings to Average option.
6. To only view linework and the last measured point, select the View Options icon or ALT-F.
7. To draw linework you must have fieldcodes established in the Feature Code List found on the

File tab.

 

 



34

Stake Points
The routine used for staking out pre-calculated points is called Stake Points and is found on the
Survey tab of the main menu.
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Defining the Point to Stake
In order to stake a pre-calculated location you must enter the point ID or coordinates into the
dialog that is presented when you enter Stake Points.

1. Enter the Stake Point ID.
2. Select OK to Stake the Point.

Tips:

1. Point by Direction can be used to quickly enter an offset location from the stake Point ID.
2. Math functions can be performed in the direction input boxes to solve inverses, etc... (e.g.

1,2 in the azimuth field would return the azimuth between points 1 and 2).
3. Math functions can also be used to quickly calculate distances in the distance input boxes

(e.g. 1,2/2 would return 1/2 the distance between points 1 and 2).
4. Multiple points can be selected using the List icon to the right of the Point ID input box or by

entering them separated by commas.
5. The Add to List button will add all points entered into the Point ID input box to the Stakeout

Point List.
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Staking Out the Point
The graphic view of Stake Points is shown below. Alternately, the user can select the TEXT
button to use a non-graphical interface to stakeout the point.

1. Select Enter or S to Store.

TEXT Mode Exit

Zoom Extents Store

Zoom In Next (Point)

Zoom Out Modify

Zoom Window Configure

Zoom Previous

View Options
Monitor 
SkyPlot

Tips:

1. Use M for Modify to enter or adjust the stake location.
2. Use N for Next to advance to the next point ID.
3. To change the behavior of the Enter key, select the C for Configure icon.
4. To change the number of epochs that Enter and S will read, select C for Configure and

change the Number of Readings to Average option.
5. To only view linework and the last measured point, select the View Options icon or ALT-F.
6. To change the method that the navigation information is reported, select C for Configure and

then the Reference tab. This is where the stakeout perspective can be changed from rod to
instrument for example.
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Feature Coding
Carlson SurvCE has the ability to draw lines live in the field based on the feature codes
established in menu item 5, Feature Code List on the FIle tab. Each code can be defined as a
point or a 2D or 3D line (polyline). In addition to the feature code, additional Special Codes can
be used to specify how the line is to be drawn.
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Create a Feature Code
To create a code:

1. Select the Add button from the Code List dialog.
2. Specify the short Code, layer for the line, full text for the list and whether or not the line is

2D or 3D. Note that the layer and 2D/3D options do not apply if the code is not a line
(polyline).

3. Select OK to save the code to the library.

Note: The New Attributes button in where all GIS style prompting is defined per code.
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User Define the Special Codes
To modify the Special Codes so that the line drawing commands fit your current codes:

1. Select the Special Codes button from the Code List dialog.
2. Select the Action that requires a different Code.
3. Enter the Code into the Code input box and select the Accept button.
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Carlson Line Coding Entry
Carlson SurvCE only requires a line code to be defined once and allows suffix numbers to
determine what points get linked together. Example, code TC can be entered as TC1 or TC2 and
so on. All TC1's will linked together and the TC2's will be a separate line. Carlson SurvCE also
allows the user to start and stop lines at any time which allows the user to reuse any line code
after it has been ended.

Tips:

1. All codes are entered into the description field.
2. All codes, including special codes, are separated by a space (e.g. TC PC).
3. All codes allow the use of numeric suffixes. Example, code TC can be used multiple times

simultaneously by add a numeric suffix to the end (e.g. TC or TC1 or TC2). This comes in
handy when cross-sectioning a road.

4. Multiple lines can be coded at a single point by simply entering the codes as FeatureCode
space SpecialCode space FeatureCode space SpecialCode and so on (e.g. TC1 -7 EP1 +7).
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Field-to-Finish
Carlson SurvCE has the Carlson Field-to-Finish line drawing routine for updating and
reprocessing line codes that were entered in the description field. If the user makes an coding
error, they can simply correct the description in the List Points dialog and run Field-to-Finish to
correct the line work.

To redraw the lines and update the drawing:

1. Select the MAP button from the main menu or, if currently in a measurement screen, select
ALT-M.

2. Select Field-to-Finish from the Tools menu.
3. Press Enter when the command line prompt shows Fld2Fin -

Update/Select/reView/<Redraw>

Tips:

1. While in a measurement screen, ALT-P will take you to the points list for editing the
descriptions.

2. If only the description its edited, the raw data file description will also be corrected to ensure
raw data processing will reflect your coding corrections.
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COGO
Carlson SurvCE has several COGO routines, many of which are located on the COGO tab. See the
MAP section of this tutorial for a brief overview of additional COGO and CAD commands that the
graphics engine supports.
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Point Projection (Solve for Station and Offset)
Point Projection (a.k.a. Inverse by Line or Perpendicular Intersection) is the COGO routine that
will compute the station (i.e. distance along an alignment) and perpendicular or radial offset to a
point or the current target position. The routine also allows the user to compute the
perpendicular or radial intersection location and stakeout the current coordinates.

To solve the perpendicular or radial offset and station:

1. Select menu item 5, Point Projection from the COGO tab.
2. Define the alignment to project the point to.
3. Enter the Point ID to query the station and offset. Alternately you can enter the coordinates

or read the current target position.

To solve the perpendicular or radial intersection point on the alignment:

1. Perform the steps above.
2. Select the Intersect button.
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Station Store (Compute by Station and Offset)
The Station Store routine is where a user can enter the station (i.e. distance along an alignment)
and perpendicular or radial offset to store a point in the job.

To store a point defined by station and perpendicular or radial offset:

1. Select Menu item 6, Station Store on the COGO tab.
2. Define or select the alignment.
3. Enter the station, offset and elevation for the point.
4. Select the Store button.
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Point in Direction (Manual Traverse)
The Manual Traverse routine allows the user to manually enter sideshot or traverse data. The
drop lists on the right side of the dialog allow the user to define the format of the data to be
entered.

1. Select menu item 9, Manual Traverse from the COGO tab.
2. Enter the sideshot or traverse data.
3. Select the Calculate button.
4. Select the Store button to store the point.

Tips:

1. Select Angle Right(AR), Angle Left(AL), Deflection Right(DR) or Deflection Left(DL) to use a
backsight point.

2. Use the TR Mode toggle to traverse and advance to the calculated point.
3. Use the El/Off toggle to be prompted for the point elevation and/or a perpendicular offset.
4. Use the Known Elevation(Z) option to traverse in 2D and enter the elevation without the

prompt.
5. To preview the computed point graphically prior to storing, select the Map button.
6. Use math functions in the input boxes (e.g. 500/2 will enter 250). See the Input Box Math

Functions section of this tutorial.
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Input Box Math Functions
Carlson SurvCE allows the user to enter math functions and different units into an input box to
have the software compute the end result. When point ID’s are used to determine a value, the
program will search for the point ID’s in the current job and if not found search in the control
job, if active.

Formatted Distance/Height Entries
Entries for distances or heights that include certain special or commonly understood
“measurement” extensions are automatically interpreted as a unit of measurement and
converted to the “working” units.  For example, a target height entry of 2m is converted to
6.5617 feet if units are configured for feet.  The “extension” can appear after the number
separated by a space or can be directly appended to the number as in 2m.  For feet and inch
conversion the second decimal point informs the software that the user in entering fractions (See
Below). Recognized text and their corresponding units are shown below:

x f or ft: US Feet
x i or ift: International Feet
x in: Inches
x cm: Centimeters
x m: Meters
x #.#.#.#: Feet and Inches (e.g. 1.5.3.8 = 1'5 3/8" either entry format is supported)

These extensions can be caps or lower case, or any combination (entries are not case-sensitive). 
These extensions are automatically recognized for target heights and instrument heights and
within certain distance entry dialogs.

Formatted Bearing/Azimuth Entries
Most directional commands within SurvCE allow for the entry of both azimuths and bearings. 
Azimuth entries are in the form 350.2531 (DDD.MMSS), representing 350 degrees, 25 minutes
and 31 seconds.  But that same direction could be entered as N9.3429W or alternately as
NW9.3429.  SurvCE will accept both forms. Additional directional entry options, which might
apply to commands such as Intersection under Cogo, are outlined below:

If Job Settings is set to Bearing and Degrees (360 circle), the user can enter the quadrant
number before the angle value.

Example
120.1234

The result is N20°12’34’’E.

Quadrants
1        NE 
2        SE 
3        SW
4        NW

In the case where Job Settings is set to Bearing and the user would like to enter an Azimuth, the
letter A can be placed before the azimuth value and the program will convert it to a Bearing.

Example
A20.1234
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The result is N20°12’34’’E.

In the case where Job Settings is set to Azimuth and the user would like to enter a bearing, the
quadrant letters can be used before the bearing value.

Example
NW45.0000

The result is 315°00’00”.

Formatted Angle Entries
Interior Angle: The user can compute an angle defined by three points by entering the point ID’
s as <Point ID>,<Point ID>,Point ID>. The program will return the interior angle created by the
three points using the AT-FROM-TO logic.  Such entries might apply to the Angle Right input box
in Sideshot/Traverse when configured to Manual Total Station.

Example
1,2,3

Using the coordinates below, the result is 90°00’00”. Point 2 would be the vertex point.

Pt.                North                East
1                5500                5000
2                5000                5000
3                5000                5500

Mathematical Expressions
Math expressions can be used in nearly all angle and distance edit boxes.  For example, within
the Intersection routine, an azimuth can be entered in the form 255.35-90, which means 255
degrees, 35 minutes minus 90 degrees.  Additionally, point-defined distances and directions can
be entered with the comma as separator, as in 4,5.  If point 4 to point 5 has an azimuth of 255
degrees, 35 minutes, then the same expression above could be entered as 4,5-90.  For math,
the program handles “/”, “*”, “-“ and “+”.  To go half the distance from 103 to 10, enter
103,10/2.

Point Ranges
When ranges of points are involved such as in stakeout lists, a dash is used.  You can enter
ranges in reverse (eg. 75-50), which would create a list of points from 75 down to 50 in reverse
order.

Survey Data Display Controls
ANGLE
The angle control will display the angle as defined by the current settings from File   Job
Settings.

Options are available for Azimuth (North or South) or Bearing combined with the option of
Degrees or Grads.

Format
The display format of degrees uses the degree, minute, second symbols. For the case of a
bearing we display the quadrant using the characters N, S, W, E.

Example Bearing
N7°09'59"E
Example Azimuth
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7°09'59"

All angular values entered by the user should be in the DD.MMSS format.

Example
7.0959
The result is 7°09'59".

Formulas
The user can use formulas for working with angles. The format must have the operator after the
angle value.
Example
90.0000*0.5
The result would be 45°00’00”

DISTANCE
The distance control will display the value using the current File   Job Settings unit. The user
can enter a formula using the mathematical operators as described above.

Inverse
The user can compute a distance from a point to point inverse by entering <Point ID>,<Point
ID>.
Example
1,2
Using the coordinates listed below, the result is 500’.
Pt.                North                East
1                5500                5000
2                5000                5000

STATION
The station control will display the value using the current File   Job Settings format.
The same options described above for distance input boxes apply.

SLOPE
The slope control will display the value using the current File   Job Settings format.
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MAP
Additional COGO routines can be located by going to the MAP screen, especially when they are
CAD based routines (e.g. Offset Polyline 2D or 3D).

To get to the MAP screen:

1. Go to the main menu.
2. Select the MAP icon in the top right corner. If in a measurement screen, select ALT-M.

The main MAP menus are shown below:

File View Draw

COGO Tools
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Equipment Settings
Instrument Baud Rate Parity Char Length Stop Bits

Ashtech/Thales 9600 None 8 1

CSI-DGPS Max 9600 None 8 1

Leica System 1200 GPS 115200 None 8 1

Leica System 500 GPS 9600 None 8 1

Leica System 50 GPS 9600 None 8 1

Leica TPS Series 19200 None 8 1

Leica Robotic Total Station 19200 None 8 1

Leica (Wild) Older Models 2400 Even 7 1

Navcom 9600 None 8 1

Nikon 310/500 4800 None 8 1

Nikon 800 9600 None 8 1

Nikon A Series 9600 None 8 1

NMEA GPS Receiver 9600 None 8 1

NovAtel 9600 None 8 1

Pentax 1200 None 8 1

Sokkia Radian 9600 None 8 1

Sokkia Radian IS 9600 None 8 1

Sokkia GSR 2600 GPS 9600 None 8 1

Sokkia GSR 2700 IS 115200 None 8 1

Sokkia Set 1200 None 8 1

Sokkia Motorized Set 9600 None 8 1

Sokkia Axis/Axis 3 GPS 9600 None 8 1

Topcon GPS+ 115200 None 8 1

Topcon GTS Series 1200 Even 7 1

Topcon 200 Series 1200 Even 7 1

Topcon 800 Direct 1200 Even 7 1

Topcon 800 Remote 4800 None 8 1

Topcon APL 1 9600 None 8 1

Topcon HiPer XT 115200 None 8 1

Trimble 5600 9600 None 8 1
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Trimble 4000 GPS 9600 None 8 1

Trimble GPS General 38400 None 8 1

Trimble Pathfinder 9600 Odd 8 1

Zeiss 50 9600 None 8 1

Zeiss RL 9600 None 8 1
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